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ABOUT MYECLIPSE

Downloaded over 10 million times, MyEclipse (http://www.
MyEclipseIDE.com) is the #1 commercial Eclipse-based IDE, 
with industry-leading support for Java and Web developers. You 
will find this card useful for introducing you to MyEclipse, as well 
as developing valuable knowledge of the expansive feature set. 

We’ll explore the basics, like how to obtain MyEclipse and install 
it, the process of getting started on projects, development 
utilizing everything from source code editors to advanced code 
completion features, project deployment, advanced debugging 
and much more. You’ll quickly discover that MyEclipse is the 
logical, Eclipse plugin-based solution for all of your J2EE 
integrated development environment (IDE) needs. 

Each MyEclipse release is available either through the MyEclipse 
Web site at http://MyEclipseIDE.com, or via the popular Pulse 
tool profiling service at http://PoweredByPulse.com. MyEclipse 
is available for the major platforms, including Windows, Linux 
and Mac, and offers industry-leading features such as:

n				Ajax & Web 2.0 tooling
   (including advanced JavaScript capabilities)   
n				Hibernate and Spring integration
n				Support for Maven configurations
n				Swing GUI design support 
n				Advanced reporting tools 
n				Industry-leading Java Persistence tooling and much more! 

 
GETTING MYECLIPSE

You can download MyEclipse a number of different ways, including:

Pulse-optimized Installer A multi-threaded automatic software provisioning 
solution that will manifest the MyEclipse install 
directly onto your machine, handling future updates 
and dependency management automatically.

All-in-One MyEclipse Installer This is a classic double-click installer that will install 
everything you need to get started with MyEclipse 
immediately.

ArchivedUpdate Site This is an Archived (ZIP) Eclipse Update Site that you 
can use when doing your own install of MyEclipse 
directly into an existing install of Eclipse.

 
Getting started with MyEclipse is really straight forward, if you 
are coming from another non-Eclipse-based-IDE, it’s good to 
know the following two things:

Views This is the term used for individual panels of 
information (like an Outline,Properties Panel,Server 
Controls Panel, etc.) 

Perspectives This is a collection of views, typically all related to 
servicing the same task (e.g. working with a database 
or working on a web project). 

You can quickly flip between the different perspectives in 
MyEclipse by using the Perspective Buttons on the top right 
of your screen: 

There are many different perspectives in MyEclipse, each one 
geared towards helping you work more efficiently with a certain 
technology or tool. They are:

Icon Description

   CVS Perspective

For CVS tools and operations

   Debug Perspective

For debugging any code you have a breakpoint 
set in (Java, JSP, JavaScript, etc.)

  Java Browsing    
            Perspective

For navigating Java class structures more intuitive 
in projects

  Java Type Hierarchy   
            Perspective

For viewing the hierarchy of types of classes

  MyEclipse AJAX    
            Perspective

For working with JavaScript and AJAX 
technologies

  MyEclipse Database 
            Explorer Perspective

For working with configured databases and 
persistence generation tools

Hot 
Tip

Working with huge projects? Increasing memory 
arguments can improve performance. We  
recommend using: -vmargs-Xms128M-Xmx512M 
-XX:PermSize=64M -XX:MaxPermSize=128M. 

You can set these arguments in the shortcut 
you use to launch MyEclipse, or edit the 
eclipse.ini file under the MyEclipse install 
directory with them. 

Perspectives 
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Icon Description

  MyEclipse Hibernate 
           Perspective

For working with Hibernate configurations, POJOs 
and HQL queries

  MyEclipse Image 
          Editor Perspective

For editing images with simple image editing tools 
provided

  MyEclipse Java 
          Enterprise Perspective

For working with MyEclipse and Web/Java EE Web 
Projects 

 MyEclipse Java    
          Persistence Perspective

For working with JPA-based entities and persistence 
technology

  MyEclipse JavaScript 
　　　　　　　　　 Perspective 

For working with JavaScript frameworks and  
source files.

  MyEclipse Report 
　　　　　　　　　 Design Perspective 

For working with the MyEclipse Reports reporting 
framework.

  MyEclipse Swing/
           Matisse Perspective 

For designing Swing GUIs using the lauded  
Matisse designer.

  MyEclipse UML 
           Perspective

For creating UML Diagrams using reverse/forward 
engineering or by hand

  Plug-in Development 
           Perspective

For working on an Eclipse-based plugin

  Resource Perspective
A simple file-explorer-esque view of projects and  
their contents

  Team Synchronizing 
           Perspective

For use with any Team (CVS, SVN, Clear Case, etc.) 
Commit/Update operations

As a quick reminder, you can lay your perspectives out anyway 
you’d like, either closing views you don’t use or adding ones you 
use all the time. Be sure to save your changes using:  Window > 
Save Perspective.

DEVELOPING WITH MYECLIPSE 

Creating Projects                                           
Working in MyEclipse, for the most part, starts first with a Project. 
You can create many different kinds of projects from the  
File > New > Project menu. 

EJB Project

Enterprise Application Project

Java Maven Project 

Java Project

Report Web Project

Web Project

Web Service Project

Hot 
Tip

All projects marked with[Optional Maven 
Support] means that when you create that 
new project, you’ll have an opportunity to 
enable Maven support on that project and use 
Maven to handle dependencies, building and 
even deployment of your project if you like.  
It’s up to you.

Editing Source Files                                              
MyEclipse supports editing many different kinds of source files 
(e.g. Java, JavaScript, HTML, XHTML, JSP, Struts/JSF/Facelet 
pages). Whenever you open a certain kind of source file, 
MyEclipse will always open that source file automatically in the 
best-suited editor for the job. You can force MyEclipse to open 
source files in different editors by right-clicking on the files and 
going to the Open With context menu. 

Hot 
Tip

If you want to permanently change a file-editor 
relationship, you can do that from the  
Window > Preferences > General > Editors > 
File Associations preference page.

While editing, you can always invoke :   

Content Assist CTRL-Space

Format Code CTRL-Shift-F

Organize Imports CTRL-Shift-O

Learning these three shortcuts can save you a lot of time.

You can combine the format code and organize import 
operation along with more code cleaning features all as part of 
saving a file (CTRL-S) automatically, so you never have to run it 
yourself. You can do this from the preference page:

Window > Preferences > Java > Editor > Save Actions

Web Application Development                                           
MyEclipse supports working on Web Projects, EJB Projects and 
Enterprise Application Projects using the following Java EE   
specification levels:

n				J2EE 1.3
n				J2EE 1.4
n				Java EE 5

Hot 
Tip

MyEclipse has visual page designers for all  
the major web technologies like Struts, JSF,
Facelets, ICEfaces, JSP and HTML.

Perspectives, continued Developing with MyEclipse, continued 
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Developing with MyEclipse, continued
Tooling                                                            
MyEclipse provides tooling for all the most popular persistence 
technologies, including full reverse-engineering and POJO/DAO 
generation support for:
n				Hibernate
n				JPA (Toplink, Hibernate & OpenJPA)                                             
n				EJB3    

Deployment & Running, continued
In addition to handling deployments and your server run-state
independently, you can also run or debug your project even faster 
by using Run As or Debug As MyEclipse Server Application 
from the project’s right-click context m enu.

MyEclipse also includes an embedded version of Tomcat as well 
as the Derby DB, allowing you to develop DB-enabled Web 
Projects right out of the box with no additional software setup. 
Or, just test your own projects instantly.

 
 Hot 

Tip

As long as your server was started in Debug 
mode, you can debug any Class or JSP resource 
easily while excercising your application by  
setting a breakpoint in the source editor.

Using Ant or Maven Builders 
A handy tip that not many people know is that besides MyEclipse 
handling builds and deployment for you, if you have custom needs 
or pre-existing Ant/Maven scripts that you want to use, you can 
easily integrate these into your build process by adding a custom 
Ant or Maven builder to your project. This will run the script, and 
the selected targets, for the following build stages:
n				After a Clean
n				During a Manual build
n				During a Auto build
n				During a Clean 

The targets to execute for each stage are fully configurable when 
setting up the custom builder. You can do that by right-clicking on 
your project and opening Properties, then going to Builders and 
clicking Add. From there you can configure the custom builder of 
your choice:

Databases 
Database Explorer makes working with your database a snap. An example of how you can visualize your tables and relationships quickly:

Wizards                                                                                      
Most all of the Web Service generation wizards can be launched 
directly from the tool bar, as well as the Web Service Explorer 
for testing your services. Just use these buttons to add services 
or explore:  

MyEclipse will automatically handle building the different kinds  
of projects for you, but also provides support for Ant and Maven, 
if you prefer to use them, to perform tasks like testing, building or 
packaging your project.

Deployment & Running 
MyEclipse provides integrated support for deploying your 
projects to your favorite application server (over 30 supported) 
in two different ways:
 Exploded: Development Mode, where saved changes are immediately hot-synced 

with the server.

Packaged: Production Mode, where a single WAR or EAR is created and deployed 
to the server. 

In addition to managing your project deployments from inside 
the IDE, you can also manage the Start, Stop and Restart cycle 
for all the most popular application servers, including Tomcat, 
Glassfish, JBoss, WebSphere, WebLogic, Resin, Jetty and more.

Frameworks                                                           
MyEclipse also supports a gamut of web services frameworks, 
including service and client generation in either bottom-up 
(from a Class file) or top-down (from a WSDL) scenarios for: 
n				JAX-WS Web Services and Clients
n				WebSphere JAX-WS and JAX-RPC Web Services
   and Client (Blue Only)
n				X-Fire based Web Services and Clients

Hot 
Tip

For really tight WebSphere deployment 
integration, check out MyEclipse Blue Edition—
it’s MyEclipse for WebSphere developers.
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WRITE LESS CODE

There are many different ways that MyEclipse helps you write 
less code. Besides providing some of the best industry-wide 
code generation wizards, we also provide support for simpler, 
every-day, enhancement like code templates, code content 
assist, and content assist templates.

Generate Getters, Setters, Delegates, Constructors

Location Source menu or right-click context menu from inside a source editor. 

Purpose To automatically generate methods or artifacts that would otherwise 
take a lot of typing to do.

Usage Invoke any of the generation commands for the type of resource you 
would like generated.

 

 
 

Hot 
Tip

Using the Surround With menu is also a big 
time saver, especially for Try/Catch blocks.

Code Templates

Location Window > Preferences > Java > Code Style > Code Templates

Purpose Allows you to control how certain blocks of code are generated, 
including default comments or templated variables.

Usage Automatic, whenever a code generation function is run (e.g. 
Generater Getters/Setters) it will use any customizations you’ve set.

Example #1: Can be used to change how new Class files are 
generated, to include a company-wide license at the top of the 
class file in a comment.

Example #2: Can be used to automatically add author, date 
and project information into a new method with a TODO marker  
until it’s implemented.

Deployment & Running, continued

 

Keyboard Shortcuts
You can have total control over your keyboard shortcuts in  
MyEclipse. All shortcuts can be adjusted from the preference 
page: Window > Preferences > General > Keys.

Common Navigation Shortcuts

CTRL-Left Click Open Declaration

F4 Open Type Hierarchy

CTRL-SHIFT-P Go to Matching Bracket

CTRL-SHIFT-R Open Resource

CTRL-O Quick Outline

ALT-Left Arrow Back in Edit History

ALT-Right Arrow Forward in Edit History

Common Coding Shortcuts 

CTRL-SHIFT-F Format

CTRL-SHIFT-O Organize Imports

ALT-SHIFT-R Rename (Refactor)

ATL-SHIFT-C Change Function Sig (Refactor)

CTRL-SHIFT-C Toggle Comment

CTRL-SHIFT-\ Remove Block Comment 

Common Debugging Shortcuts

ALT-SHIFT-D, J Debug Java Application

CTRL-F11 Run Last Launched

F11 Debug Last Launched

CTRL-SHIFT-I Inspect Value

F5 Step Into

F6 Step Over

F7 Step Return

F8 Continue Execution

CTRL-SHIFT-B Toggle Breakpoint

Common View Shortcuts

CTRL-M Maximize/Restore View

CTRL-F6 Next Editor

CTRL-SHIFT-F6 Previous Editor

CTRL-F8 Next Perspective

CTRL-SHIFT-F8 Previous Perspective

CTRL-E Quick Switch Editor
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Write Less Code, continued

Content Assist

Location (Inside source code, invoked with CTRL-Space 
key sequence.)

Purpose To provide help completing method calls as well 
as naming variables based on the type they are.

Usage CTRL-Space while editing, any time, to see if 
MyEclipse has suggestions for you based on 
the current context. Completions are location-
sensitive.

 

Example #1: String name = new |<-- Invoke here for ’String’, 

since it will match the type of the variable.

Example #2: MyClass |<-- Invoke here for "myClass" and a few 

other common variations based on the type name.

Content Assist Templates   

Location Window > Preferences > Java > Editor > 
Templates

Purpose To create custom content assist suggestions 
based on your coding style.

Usage CTRL-Space while editing, if the name sequence 
partially matches, will include whatever
templates you have created with that name.

 

Example #1: Create a template "myfor" that creates a complex 

for-loop, including comments and templated argument variables. 

Type "my" or "myfor" and hit CTRL-Space to have your 

template inserted.

Example #2: There is a huge set of pre-defined templates you 

can already use. For example, try "sysout" and hit CTRL-space.

Hot 
Tip

Code Assist Templates also have a specified 

“context” that they apply to (e.g. in Javadoc,  

or in Java source code).

 
 

WORK AS A TEAM 

MyEclipse supports integrated team source control tools like 
CVS out of the box. You can add support for your favorite 
source control system (Subversion, Perforce, Clear Case, etc.) all 
by adding the appropriate plugin to your MyEclipse install.

Version control allows you to easily keep your work safely 
versioned and combined with other team-member’s work 
without needing to send emails back and forth to your team 
members with your changes in them.

Integrated Team (Version Control) operations can all be 
accessed from the Team menu off of the right-click context 
menu on your project. This includes:

n				Update Commit
n				Branch / Tag
n				Merge
n				Show History
n				and every other operation you could need!
 

EXTENDING MYECLIPSE — PLUG-INS

Since MyEclipse is built on top of the Eclipse platform, you can 
easily extend it with any of your favorite Eclipse plugins in the 
same way you might extend Eclipse.

Hot 
Tip

A good resource for plugins is www.eclipse-
plugincentral.com.

 
In addition to finding and installing your own plugins manually, 
you can use Pulse (www.poweredbypulse.com) to create 
a MyEclipse-based software profile and then Drag and 
Drop software from the included software catalog into the 
profile. Pulse will handle installing and running that for you 
automatically. You can even share these profiles with friends, 
co-workers and teams.

WEB SITE REFERENCES

By reviewing and utilizing the helpful hints in this guide, you’ve 
already placed yourself a step ahead of the competition. MyEclipse 
is a pervasive tool in the Eclipse space, and there are multiple 
Web sites you can visit for more information and helpful hints. 

→
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Web Site References, continued
We recommend the following specific sites to get the most out 
of your MyEclipse experience.

Web Resources Description

MyEclipse Home Page
myeclipseide.com

Where it all begins for MyEclipse users. 
Includes links for education, support and more.

MyEclipse Blue Edition 
myeclipseide.com/blue

Explore all that MyEclipse Blue Edition has 
to offer for WebSphere users.

MyEclipse Blog 
jroller.com/myeclipseblog

The best way to keep up with MyEclipse 
happenings.

MyEclipse Webinars 
myeclipseide.com/webinars.html

Free Webinars that demonstrate some of 
the most popular features of MyEclipse.

Web Resources Description

Pulse 
poweredbypulse.com

Genuitec’s powerful Eclipse tool profiling 
solution - can help manage MyEclipse.

Genuitec 
genuitec.com

Genuitec, the parent company behind 
MyEclipse and Pulse products.

Eclipse Zone
http://eclipse.dzone.com

Community for Eclipse users and developers. 

Eclipse Plugin Central 
eclipseplugincentral.com 

The best and most extensive repository of 
Eclipse plugins.

Eclipse Foundation 
eclipse.org 

Genuitec is a strategic member of the 
Eclipse Foundation.
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